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 Getting Started with the Guardian Power Quality Recorder 
 

 

 

The Guardian power analyzer from Power Monitors Inc. is designed for use in a 200A 

residential meter base with the existing revenue meter. In addition to RMS voltage and current 

as in the 2SX+ recorder, the Guardian comes standard with the ability to measure and monitor 

power factor, demand, phase angle, and harmonics to the 51st, and new features like E-mail & 

text alerts through the PQ Canvass web-interface, network time sync, Wi-Fi, Cell Modem, 

CBEMA / ITIC recording, enhanced waveform capture, and with cellular or Ethernet 

connectivity, the ability to send data to the PQ Canvass web servers, in an all-weather, self-

contained, unit and uses surface mount technology 
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Safety Information 
Safety Notice  

Please read this before installing the Guardian™. The Guardian recorder contains dangerous voltage levels 

during operation. Do not disassemble the recorder. 

 THERE ARE NO USER SERVICEABLE PARTS INSIDE. 

 Do not install or operate near open bodies of water.  

The Guardian is intended for use with a standard 2S meter base, with the appropriate revenue meter plugged 

into the meter base.  

Always wear protective gloves and safety glasses during installation and operation of the Guardian. If possible, 

disconnect power during installation.  

If the green ground clip is damaged or detached, call PMI for a replacement.  

Do not install the Guardian if the green ground clip cannot be attached to earth ground.  

When removing an installed Guardian, always completely remove the revenue meter before attempting to 

remove the recorder from the meter socket.  

The USB port is electrically isolated from the 120VAC line. However, to ensure user safety and prevent damage 

to the unit, plug only the supplied Guardian USB cable into this port. Plug the other end of the 

communications cable into a USB port.  

Although the Guardian has been designed and built to be as safe as possible, great care should be exercised at 

all times during operation and installation. 

 Always follow the National Electric Code as well as any local safety procedures.  

SIGNAL INPUTS WARNING  

Use extreme caution when wiring signal input connections. Hazardous potentials may exist on signal input 

terminals, which are floating, with respect to instrument ground. These hazardous potentials may be exposed 

inside the instrument case and on the Connectors of your instrument. Any voltage potential at the signal 

source will exist on the instrument's respective signal input cable. 
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Introduction  
 

Power Monitors Incorporated (PMI), an industry-leading product design and manufacturing firm based in Mt. 

Crawford, Virginia, specializes in applying advanced technologies to develop stateof-the-art power quality 

recording solutions for residential, commercial, retail, institutional, industrial, and substation applications. 

Since 1987, we have worked directly with electrical utilities and their customers to identify and address a wide 

array of power quality concerns. We pride ourselves in delivering leading-edge recorders and software that 

are as easy to use as they are affordable. Our 24/7 technical support is consistently rated "best in the 

business."  

Dedicating ourselves to this high standard of quality, we have developed the Guardian™ meter socket 

recorder. The Guardian combines the powerful, technologically advanced analysis capabilities of our other 

recorders with the specific needs of single-phase meter base applications. We developed the Guardian meter 

socket recorder specifically to diagnose and record power quality issues at the revenue meter. The unit plugs 

into any standard 2S meter socket to measure and record voltage, current, power, harmonics, and more, 

detecting outages, sags, swells, and flicker.  

We created the lightweight and rugged Guardian with your needs in mind. It is perfect for analyzing electrical 

power issues at the consumer level. After looking through this manual and using the Guardian meter socket 

recorder, please contact us if you have any questions about its operation or if you have any ideas for new 

features or additional products. Total customer satisfaction is our primary goal, and we appreciate any input 

to help us develop products to meet your future needs. We are always available to discuss how PMI can help 

you meet your power monitoring needs.  
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Guardian PQ recorder Overview 

 
The Guardian PQ recorder has connectivity options that include cell modem, Wi-Fi, Blue Tooth, and direct 

connect using a USB cable. Refer to the section on connecting the Guardian. 

Physically connecting the Guardian recorder to a meter base is the same as connecting other PMI socket 

recorder. Refer to the section on Installation. 

The Guardian has more recording features than older socket recorders, and the initialization settings are 

similar to the Revolution recorder. 

The Guardian recorder must first be initialized. This is done by either connecting the Guardian meter socket 

recorder to your computer using the USB communications cable that came with the recorder or wirelessly 

using a Cell or Bluetooth® connection and using the ProVision software. The ProVision software is used to 

download the data to a file and analyze the recorded data. 

The latest ProVision software and USB driver software can be downloaded from the Power Monitors  

Website: https://powermonitors.com/downloads 

Download the Provision manual from: https://powermonitors.com/downloads 

 

Differences from other PMI recorders 

 
The Guardian contains no batteries. It does have super capacitors to provide short ride-through capabilities 

during a power outage. 

The Guardian will flash a red/orange LED when powering up. 

It may take longer to connect to Provision than other recorders, due to a longer boot up cycle.  

When in Idle mode, the LED will flash Green twice, either; 5 seconds on/1 second off or 2 seconds on/3 

seconds off, then repeat the sequence.  

When recording the LED will flash the Green LED on for 1 second/off for 5 seconds, then repeat the sequence. 

There is a shorter initialization time and the LED - ‘2 minute’ countdown on/off pattern lasts for 10 seconds. 

Any repeating Red LED indicates a fault. 

 

 

https://powermonitors.com/downloads
https://powermonitors.com/downloads
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Installation 
 Please read the safety section carefully before installation. Always exercise extreme caution when installing 

the Guardian meter socket recorder. Interrupt the electrical service to the point of connection whenever 

possible. Always wear gloves and safety glasses, as well as any additional applicable protective equipment. Do 

not install the Guardian unless you are qualified by your utility to install and remove revenue meters.  

Remove the revenue meter at the installation site using normal safety precautions. Make whatever notations 

your procedures require about the status and identification of the meter at the time of removal. Attach the 

green ground clip (found on the rear of the recorder) to earth ground, or the ground from the service drop. 

Install the Guardian meter socket recorder in the meter socket by sliding the blades of the recorder into the 

receptacles in the socket. The top of the unit is marked with a sticker inside the front face. If the ground clip is 

damaged, please call PMI for a replacement cable. The ground clip MUST be connected for proper recorder 

operation.  

Use the locking ring supplied with the Guardian to secure the recorder to the meter base.  

Reinstall the revenue meter using the front of the Guardian recorder as the meter socket. Attach the clamp or 

locking ring you would normally use to install a meter. The Guardian socket should accommodate the existing 

hardware. Secure your utility’s standard meter seal and make any notations your procedures require about 

the status and identification of the meter at the time of installation. 
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Connecting the Guardian Recorder to ProVision  

Using the Cell modem 

 

How to configure ProVision to access an IP address 

 

In ProVision, Select the 'Options' tab 

Next, select 'Communication port settings' 

 

 
 

Click the 'Add' button, then TCP/IP 

Change the Name to reflect the serial number or identifier of choice 

Change the Address to the assigned IP number  

Check the 'This is a Cell Connection' box 

 

Select Save 
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The entry will be listed under the TCP/IP heading 

 

Select Close 

 

How to connect a cell Guardian to ProVision using the IP address 

 

Select the 'Recorder tab' and select 'Connect Recorder' 

Select the new entry for the Guardian 

You should see Guardian (serial number) listed in the Devices column with a Yellow lightning bolt in front of it. 

(Not seeing the Devices column? Select the View tab and click on Devices). 

 

 

You can now initialize, download, or view live data on the Guardian recorder. 
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Disconnecting the Cell Guardian recorder from Provision 

 

Select the Recorder tab and then select ‘Disconnect Recorder’ 

 

After disconnecting, the lightening bolt will have a red mark in it 

 

The Guardian name will remain under the Devices column.  

To quickly reconnect, right-click on the name and select ‘Connect’ 

To remove the listing, right-click on the name and select ‘ Delete’  

NOTE: A second Guardian name will show if connecting using the USB cable and also connecting by cell. 
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Connecting a Guardian Recorder to ProVision – Using Wi-Fi 

How to configure ProVision to access the Wi-Fi IP address 

 

In ProVision select the 'Options' tab 

Select 'Communications port settings' 

 

Click the 'Add' button, then TCP/IP 

Change the Name to ‘Guardian Wi-Fi’ 

Change the Address to 172.16.32.1 

 

Select Save 

The entry will be listed under the TCP/IP heading 

 

Select Close 
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How to connect your PC to the Wi-Fi network 

Before connecting ProVision to your Wi-Fi Guardian, you must connect your PC to the Guardian WiFi network. 

Contact your IT person if Wi-Fi is not enabled on your PC or Laptop 

(Windows 10 example)  Select the network icon  located on the desktop at the bottom-right 

For Guardian recorders in Wi-Fi range, a list of Guardian serial numbers will display. 

Select the target serial number and ‘Connect’ 

*First time connections will be asked for a password – Contact PMI Technical Support for the password 

 

 

 

Once the connection is established, return to Provision and connect to the GuardianWi-Fi IP address. 
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How to connect ProVision to a Wi-Fi Guardian recorder 

Select the 'Recorder tab' and select 'Connect Recorder' 

Select the entry for the Guardian Wi-Fi 

You should see Guardian  (serial number) listed in the Devices column with a yellow lightning bolt in front of it. 

(Not seeing the Devices column? Select the View tab and click on Devices) 

 

 

You can now initialize, download, or view live data on the Guardian recorder. 

Disconnecting the Guardian recorder from Provision (Wi-Fi) 

Select the Recorder tab and then select ‘Disconnect Recorder’ 

 

After disconnecting 

 

The Guardian name will remain under the Devices column.  

To quickly reconnect, right-click on the name and select ‘Connect’ 
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If you have multiple Guardian Wi-Fi recorders, it is best to remove the name every time you disconnect.  

Right-click on the name and select ‘ Delete’. 

Go back to the PC network setting and also disconnect from the Wi-Fi network 

 

Connecting the Guardian recorder to ProVision – Using the USB cable 

 

Get the latest USB driver for Windows 7,8, and 10 from the Power Monitors.com 

Website: https://powermonitors.com/downloads 

The Guardian will auto-connect to Provision. 

You can initialize, download, or view live data on the Guardian recorder using ProVision 

Disconnecting the Guardian recorder from Provision (USB) 

Unplug the USB cable from the PC 

The Guardian listing in the Devices column will disappear. 

Notes: 

1) In Provision, if you are also using PQ Canvass, the cell Guardian date-and-time will show in UTC time 

(Coordinated Universal Time, formerly GMT).  

Subtract 5 hours for Eastern Standard time (4 hours during Daylight Saving Time).  

2) If you are not using PQCanvass, the setting can be changed to use the local time.  

3) The Guardian recorder will be in either the Standby Mode or Ready Mode. In Standby Mode the 
Guardian is not recording. In Ready Mode the Guardian is recording data. Selecting Provision 
commands may switch the modes automatically. To manually change the mode, select the Mode from 
the Recorder tab.  

                             
Refer to the ProVision manual for more information 

https://powermonitors.com/downloads
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Initialization 
The Guardian PQ recorder must be initialized with ProVision prior to using. The Guardian can be powered 

from the USB cable connection with no AC power applied or mounted in a meter base, then connected to 

ProVision using Bluetooth®, cellular, or USB connections. (Do not connect a damaged USB cable) 

Select the settings in the initialization screens to enable the Guardian to record the correct information for 

your trouble site. It is best to initialize whenever the Guardian is moved to another site, so you have separate 

data files for each location. If you do not initialize, the data will append to the previous data.  

ProVision has the ability to ‘join’ several files into one for easier data analysis of long term recording 

To initialize, use one of the connection methods described in the section titled – Connecting the Guardian 

Recorder to ProVision.  

The Guardian will show in the Devices pane of ProVision when connected. 

 

Right click on the Guardian entry, or select the Recorder tab at the top of ProVision and then select Initialize. 

You could also select ‘Retrieve Settings’ to pull the current settings from the Guardian to view or modify the 

settings 
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The Basic and Advanced Initialization pages contain the settings for the Interval ‘Stripcharts’, both graphs and 

reports. A 1-Minute Interval will show the lowest cycle, the highest cycle and the average of the samples ( 256 

samples per cycle) for each minute of recording. A 1-Minute interval is a good setting for most recordings. 

 

Selecting more or fewer recording options will change the Record Time (the time it takes to ‘fill up’ the 

Guardians memory and start to over write the earlier data) 

The other tabs such as Waveforms or Events, have their own memory and do not change the Interval Record 

Time. Set only channels 1 and 2 for the Guardian. 

 

When completed choose Finish at the bottom right of the screen, then select Yes to initialize.  

After downloading a recording you will be asked to initialize the recorder, selecting Yes will use the same 

settings as the previous recording.  

Recording Templates can be created to standarize the settings, this makes it easy to ‘drop’ the settings onto 

the recorder  

Complete Initialization information can be found in the PoVision manual.  
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Downloading 
Once you have complete the recording, the Guardian will need the data downloaded into ProVision for analysis. 

To start the download procedure, connect the Guardian to ProVision using the USB cable, cellular or Bluetooth® 

connections. Right click on the Guardian listed in the Devices pane and select Download Recording or select Download 

Recording from the Recorder menu 

 

 

When the recording has finished downloading, you will be asked to name the recording and then asked to initialize. 

Choosing Yes will initialize the Guardian with the same settings as the previous recording. You can choose no and 

initialize the recorder at a later time.  

The data in memory will not be removed until the Guardian is powered on AC power 

If connected over a cellular or Bluetooth® connection, be sure to perform a  ‘Disconnect’ to start the new recording.  

See the ProVision manual for details on viewing the different graphs and reports stored in your data file.  
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PQ Canvass 
The PQ Canvass website is located:    https://pqcanvass.powermonitors.com 

Login and password is needed. Contact PMI Tech Support for assistance. 

See the PQ Canvass Getting Started Guide for more information: https://powermonitors.com/downloads 

Overview 

PQ Canvass is a cloud-based system for power quality analysis, it contains most graphs and reports that are 

used by ProVision, including live waveform graphs and histograms. 

As a Guardian is recording data, that data is also being saved in PQ Canvass as a ‘live’ recording. 

When a Guardian is downloaded and initialized using ProVision, the ‘live’ recording is stored in PQ Canvass. 

In PQ Canvass you can view the ‘live’ recording or any of the stored recordings. 

If you initialize a Guardian and never download it using ProVision, PQ Canvass will continue adding to the ‘Live’  

   recording while the data in the Guardian will be continually  overwritten. 

PQ Canvass Main Map View 

 

Blue icons ae ‘live’ active recorders, Black icons are non-active recorders and Amber icons are in an alert state. 

You can select an icon to view the Device Information for that recorder, and view ‘iive’ waveform captures. 

https://pqcanvass.powermonitors.com/
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PQ Canvass Control Icons 

 

Devices icon  list all Recording devices associated with your company 

Selecting a device from the list or from the map displays that device’s Quick Access View menu 

PQ Canvass Quick Access View 

Select Overview or Graphs to see graphs displaying data in 1 second averages, Live Data to see live data in a 

waveform view or a meter view, or Recording for Power Quality (PQ) data file based on initialization and 

trigger settings. See the PQ Canvass User Guide for detail instructions. 

 

 

 



pg. 19 
 

Opening a Recording 

To see a list of all Power Quality (PQ) recordings for every device, select the recordings icon  at the 

bottom of the page. Then select a data file. 

The Header Report will be displayed showing information about the recording 
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Working with Graphs 

Select the Interval, Daily Profiles, Histogram or Waveform Captures to see the sub menus 

Select the desired Graph. Grayed out selections are not contained in the recorded graph 
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RMS Voltage and Current shows min, max, and averages 

Waveform Capture overlays  can be applied to the graphs 

 

 New Graph,  Set Timespan,  Customize Axis,  Toggle Show/Hide Annotations,   Select Tool, 

  Save Graph    Zoom Out,  Zoom In, Toggle Graph Overlays,  Back/undo,  Home/Revert 

 Next/Redo,  Reload,  Annotate Graph,  Graph Template Editor,  Print Graph,  Per Unit Scaling 

 Quick Editor lets you de-select graph traces, or re-select them as needed 
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Opening a Report from a PQ Data File 

Select a report from the header report list 

 

Then select desired report 

 

 New Recording (Initialization options) 

To start a new recording (which creates a PQ data file) the Guardian must be initialized at least once (the PQ 

data file will continue to update until the next initialization) and initialized whenever the Guardian is moved to 

another site. This creates separate PQ data files for each location. 

To initialize a recorder, go to the Recorder’s Quick Access View page and select Recordings then select 

 New Recording. A list of templates is available with preset recording options. 

General Purpose contains all the settings available; all other templates will be subsets of these settings or 

contain specific settings.                

Set or remove check marks to  adjust what is recorded. Select [Start Recording] when you have completed 

your selections     

There are many settings and different models of recorders will have different selections available, see the PQ 

Canvass User manual for more information. 
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PQ Canvass - Setting Alert Notifications 
PQ Canvass can be configured with your Guardian or other models to send email or SMS (text) alerts when the 
trigger thresholds of a monitored setting are reached. The Notification List must be configured, then each 
device will need its Trigger Thresholds set. 
 

 

 

Refer to the PQ Canvass Getting Started Guide and the PQ Canvass User Manual for more details on setting 

alerts. 
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Technical Support 
Help is always available if one needs additional assistance. The technical support team at PMI is widely 

considered to be the best in the industry. Use one of the following methods to obtain technical support. 

 

Email Support 

Send email to: techsupport@powermonitors.com 

 

Web Support 

Submit a support request via the web at https://powermonitors.com/support 

 

Telephone Support 

Contact us 24 hours a day, 7 days a week for live tech support by calling: 

(800) 296-4120 

Faxes should be sent to: (540) 432-9430 

 

Postal Mail Support 

All correspondence by post should be addressed to:  

Power Monitors, Inc. 

800 North Main Street 

Mount Crawford, VA 22841 

USA  

 

https://powermonitors.com/support

